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Installation pfSense sur VMware
Guide complet pour installer et configurer pfSense sur VMware avec plusieurs interfaces réseau
(WAN, LAN1, LAN2)

Systèmes 45 min de lecture Niveau Intermédiaire
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Guide  complet  pour  installer  et  configurer  pfSense  sur  VMware  avec  plusieurs  interfaces
réseau.

Introduction

pfSense  est  un  firewall/router  open  source  basé  sur  FreeBSD.  Ce  guide  vous  explique
comment  l'installer  sur  VMware  avec  plusieurs  interfaces  réseau  pour  créer  un
environnement  de  test  réseau  isolé.

Prérequis

VMware Workstation Pro ou VMware Fusion

Accès administrateur sur votre machine

Fichiers ISO pfSense disponibles dans le projet

1️⃣ Fichiers ISO pfSense

Fichiers disponibles

Les fichiers d'installation pfSense sont disponibles dans le projet :

Pour architecture AMD64/x86_64 (Recommandé pour VMware)

Fichier ISO : netgate-installer-amd64.iso

Architecture : AMD64 (64-bit)

Usage : Pour la plupart des machines virtuelles VMware

Pour architecture ARM64 (aarch64)

Fichier IMG : netgate-installer-aarch64.img

Architecture : ARM64

Usage : Pour les machines ARM (Apple Silicon avec émulation, Raspberry Pi, etc.)

Note importante

Pour  VMware  sur  architecture  x86_64  (Intel/AMD),  utilisez  le  fichier  netgate-installer-
amd64.iso.

2️⃣ Création de la VM VMware

Étape 1 : Créer une nouvelle machine virtuelle

Ouvrez VMware Workstation (ou VMware Fusion sur macOS)1.

Cliquez sur File → New Virtual Machine (ou ⌘N sur Mac)2.

https://nouvy-agency.fr/wiki-elements/isos-pfsense/netgate-installer-amd64.iso
https://nouvy-agency.fr/wiki-elements/isos-pfsense/netgate-installer-aarch64.img


Sélectionnez Typical (recommended) et cliquez sur Next3.

Étape 2 : Sélectionner l'ISO

Choisissez Installer disk image file (iso)1.

Cliquez sur Browse et sélectionnez le fichier ISO pfSense : netgate-installer-2.
amd64.iso (disponible dans /wiki-elements/isos-pfsense/)

Cliquez sur Next3.

Étape 3 : Configurer le système d'exploitation

Guest operating system : Sélectionnez Other1.

Version : Sélectionnez FreeBSD 12.x 64-bit ou FreeBSD 13.x 64-bit (selon la2.
version de pfSense)

Cliquez sur Next3.

Étape 4 : Nommer la VM

Virtual machine name : pfSense (ou un nom de votre choix)1.

Location : Choisissez l'emplacement où stocker la VM2.

Cliquez sur Next3.

Étape 5 : Configurer le disque

Maximum disk size : 20 Go (recommandé, minimum 10 Go)1.

Cochez Split virtual disk into multiple files (recommandé pour faciliter le2.
déplacement)

Cliquez sur Next3.

Étape 6 : Personnaliser le matériel

Cliquez sur Customize Hardware avant de finaliser1.

Memory : Allouez 2048 MB (2 Go) minimum (1024 MB peut fonctionner mais 2 Go2.
est recommandé)

Processors : 1 processeur avec 1 core est suffisant3.

Cliquez sur Close puis Finish4.

3️⃣ Configuration des cartes réseau

Vue d'ensemble

Pour ce guide, nous configurons 3 interfaces réseau :

Carte Type VMware Usage IP

WAN NAT ou Bridged Accès Internet depuis pfSense Auto (DHCP)

LAN1 Host-only Réseau interne 1 pour vos VM ou PC hôte 192.168.1.1/24

LAN2 Host-only Réseau interne 2 isolé 192.168.2.1/24



Étape 1 : Accéder aux paramètres réseau

Sélectionnez votre VM pfSense1.

Cliquez sur Edit virtual machine settings (ou Settings)2.

Allez dans l'onglet Network Adapter3.

Étape 2 : Configurer la première carte (WAN)

Network Adapter 1 :1.
Network connection : Sélectionnez NAT (ou Bridged si vous voulez une
IP sur votre réseau physique)

Cochez Connect at power on

Cliquez sur Advanced → Notez le MAC Address (ex: 00:0C:29:XX:XX:XX)

Étape 3 : Ajouter la deuxième carte (LAN1)

Cliquez sur Add...1.

Sélectionnez Network Adapter → Finish2.

Network Adapter 2 :3.
Network connection : Sélectionnez Host-only (ou Custom: VMnet2)

Cochez Connect at power on

Étape 4 : Ajouter la troisième carte (LAN2)

Cliquez à nouveau sur Add...1.

Sélectionnez Network Adapter → Finish2.

Network Adapter 3 :3.
Network connection : Sélectionnez Host-only (ou Custom: VMnet3)

Cochez Connect at power on

Étape 5 : Créer des réseaux Host-only distincts (Optionnel mais
recommandé)

Pour isoler complètement LAN1 et LAN2, créez deux réseaux Host-only distincts :

Sur VMware Workstation :

Allez dans Edit → Virtual Network Editor1.

Cliquez sur Add Network...2.

Sélectionnez VMnet2 → OK3.

Configurez :4.
Type : Host-only

Subnet IP : 192.168.1.0

Subnet mask : 255.255.255.0

Décochez Use local DHCP service (pfSense gérera le DHCP)

Répétez pour VMnet3 avec :5.
Subnet IP : 192.168.2.0

Subnet mask : 255.255.255.0

Sur VMware Fusion (macOS) :



Allez dans VMware Fusion → Preferences → Network1.

Cliquez sur + pour ajouter un réseau2.

Configurez le premier réseau Host-only pour LAN13.

Répétez pour le deuxième réseau Host-only pour LAN24.

4️⃣ Installation de pfSense

Étape 1 : Démarrer la VM

Sélectionnez votre VM pfSense1.

Cliquez sur Power on this virtual machine2.

La VM démarre et affiche le menu d'installation pfSense3.

Étape 2 : Menu d'installation

Vous verrez le menu suivant :

Welcome to pfSense (amd64) Installer

[OK] - Accept and continue with default keymap
[Cancel] - Cancel installation

Select an option:

Copier

Appuyez sur OK pour continuer avec le clavier par défaut1.

Étape 3 : Installer pfSense

Sélectionnez Install dans le menu principal1.

Choisissez Auto (UFS) - Guided Disk Setup pour le partitionnement automatique2.

Sélectionnez le disque (généralement ada0)3.

Choisissez Entire Disk pour utiliser tout le disque4.

Sélectionnez GPT comme schéma de partition5.

Confirmez l'installation en sélectionnant Commit6.

Étape 4 : Configuration du fuseau horaire et clavier

Fuseau horaire : Sélectionnez votre fuseau (ex: Europe/Paris)1.

Clavier : Sélectionnez votre disposition de clavier (ex: French)2.

Étape 5 : Finalisation de l'installation

L'installation commence et copie les fichiers1.

Une fois terminée, sélectionnez Reboot2.

Important : Retirez l'ISO avant le redémarrage :3.
VMware Workstation : VM → Settings → CD/DVD → Uncheck "Connect at
power on"



VMware Fusion : VM → Settings → CD/DVD → Uncheck "Connect CD/DVD
Drive"

Étape 6 : Redémarrage

La VM redémarre1.

pfSense démarre et affiche le menu de configuration2.

5️⃣ Assignation des interfaces réseau

Étape 1 : Menu de configuration initial

Au démarrage, pfSense affiche :

*** Welcome to pfSense 2.7.x-RELEASE (amd64) on vmware ***

 WAN (wan)       -> em0       -> v4/DHCP4: 192.168.x.x/24
 LAN (lan)       -> em1       -> v4: 192.168.1.1/24

 0) Logout (SSH only)                   9) pfTop
 1) Assign Interfaces                    10) Filter Logs
 2) Set interface(s) IP address         11) Restart webConfigurator
 3) Reset webConfigurator password       12) PHP shell + pfSense tools
 4) Reset to factory defaults            13) Update from console
 5) Restart webConfigurator              14) Enable Secure Shell (sshd)
 6) Halt system                          15) Restore configuration
 7) Ping host                            16) Restart PHP-FPM
 8) Shell                                17) Clear package lock

Enter an option:

Copier

Étape 2 : Assigner les interfaces

Tapez 1 et appuyez sur Enter pour Assign Interfaces1.

pfSense  détecte  automatiquement  les  interfaces.  Vous  verrez  quelque  chose2.
comme :

Valid interfaces are:

em0    00:0c:29:xx:xx:xx  (up)
em1    00:0c:29:xx:xx:xx  (up)
em2    00:0c:29:xx:xx:xx  (up)

Do you want to set up VLANs now? [y|n]

Copier

Tapez n (pas de VLAN pour l'instant)3.



Assign WAN interface : Tapez em0 (ou laissez par défaut si déjà assigné)4.

Assign LAN interface : Tapez em15.

Do you want to assign OPT1? : Tapez y6.

Assign OPT1 interface : Tapez em27.

Confirmez l'assignation8.

Étape 3 : Renommer les interfaces (Optionnel)

pfSense vous demandera si vous voulez renommer les interfaces :

WAN : Laissez WAN (ou renommez si vous préférez)

LAN : Renommez en LAN1 (ou laissez LAN)

OPT1 : Renommez en LAN2

6️⃣ Configuration des adresses IP

Étape 1 : Configurer WAN

Dans le menu principal, tapez 2 pour Set interface(s) IP address1.

Sélectionnez WAN (option 1)2.

Configure IPv4 address : Sélectionnez DHCP (pour NAT) ou Static (pour Bridged)3.

Si Static, entrez :4.
IPv4 address : L'adresse IP de votre réseau

Subnet mask : Le masque de sous-réseau

Gateway : La passerelle par défaut

Configure IPv6 : Sélectionnez None (ou configurez si nécessaire)5.

Étape 2 : Configurer LAN1

Sélectionnez LAN1 (ou LAN) dans le menu1.

Configure IPv4 address : Sélectionnez Static2.

Entrez :3.
IPv4 address : 192.168.1.1

Subnet mask : 24 (ou 255.255.255.0)

Configure IPv6 : Sélectionnez None4.

Étape 3 : Configurer LAN2

Sélectionnez LAN2 (ou OPT1) dans le menu1.

Configure IPv4 address : Sélectionnez Static2.

Entrez :3.
IPv4 address : 192.168.2.1



Subnet mask : 24 (ou 255.255.255.0)

Configure IPv6 : Sélectionnez None4.

Étape 4 : Activer le DHCP sur LAN1

Retournez au menu principal1.

Tapez 2 pour Set interface(s) IP address2.

Sélectionnez LAN13.

Do you want to enable the DHCP server? : Tapez y4.

Enter the start address of the IPv4 client address range : 192.168.1.1005.

Enter the end address of the IPv4 client address range : 192.168.1.2006.

Enter the IPv4 upstream gateway : Laissez vide ou entrez 192.168.1.17.

Enter the primary DNS server : 8.8.8.8 (Google DNS) ou votre DNS préféré8.

Enter the secondary DNS server : 8.8.4.4 (Google DNS) ou laissez vide9.

Étape 5 : Activer le DHCP sur LAN2 (Optionnel)

Répétez les étapes pour LAN2 avec :

Start address : 192.168.2.100

End address : 192.168.2.200

7️⃣ Accéder à l'interface web

Étape 1 : Configurer votre PC hôte

Pour accéder à l'interface web de pfSense, connectez votre PC hôte à l'un des réseaux Host-
only :

Sur VMware Workstation :

Allez dans Edit → Virtual Network Editor1.

Sélectionnez le réseau Host-only correspondant (VMnet2 pour LAN1)2.

Cliquez sur NAT Settings → Notez l'adresse IP du réseau3.

Configurez votre carte réseau Windows :4.
IPv4 : 192.168.1.10 (ou une autre IP dans la plage 192.168.1.0/24)

Subnet mask : 255.255.255.0

Gateway : 192.168.1.1

DNS : 192.168.1.1 ou 8.8.8.8

Sur macOS :

Allez dans Préférences Système → Réseau1.

Sélectionnez le réseau VMware Host-only2.

Configurez :3.
IPv4 : 192.168.1.10

Subnet mask : 255.255.255.0



Router : 192.168.1.1

Étape 2 : Accéder à l'interface web

Ouvrez votre navigateur web1.

Accédez à : http://192.168.1.1 (pour LAN1) ou http://192.168.2.1 (pour LAN2)2.

Vous verrez la page de connexion pfSense3.

Étape 3 : Identifiants par défaut

Username : admin

Password : pfsense

⚠️ Important : Changez le mot de passe lors de la première connexion !

Étape 4 : Assistant de configuration

Lors de la première connexion, l'assistant de configuration pfSense s'affiche :

Welcome : Cliquez sur Next1.

General Information :2.
Hostname : pfsense (ou votre choix)

Domain : local (ou votre domaine)

Primary DNS Server : 8.8.8.8

Secondary DNS Server : 8.8.4.4

Time Server Information : Configurez le serveur NTP3.

WAN Configuration : Vérifiez les paramètres WAN4.

LAN Configuration : Vérifiez les paramètres LAN15.

Set Admin Password : Changez le mot de passe admin !6.

Reload : Cliquez sur Reload pour appliquer les changements7.

8️⃣ Configuration du firewall et routage

Par défaut : Isolation des réseaux

Par défaut, LAN1 et LAN2 sont isolés et ne peuvent pas communiquer entre eux. C'est
une fonctionnalité de sécurité.

Autoriser le trafic entre LAN1 et LAN2

Si vous voulez permettre la communication entre les deux réseaux :

Option 1 : Via l'interface web (Recommandé)

Connectez-vous à l'interface web pfSense1.

Allez dans Firewall → Rules2.

Sélectionnez l'onglet LAN23.

Cliquez sur Add pour créer une nouvelle règle4.

http://192.168.1.1
http://192.168.2.1


Configurez la règle :5.
Action : Pass

Interface : LAN2

Protocol : Any (ou sélectionnez TCP/UDP selon vos besoins)

Source : LAN2 net (ou 192.168.2.0/24)

Destination : LAN1 net (ou 192.168.1.0/24)

Description : Allow LAN2 to LAN1

Cliquez sur Save6.

Cliquez sur Apply Changes7.

Option 2 : Règle bidirectionnelle

Pour permettre la communication dans les deux sens :

Créez une règle sur LAN2 : Source LAN2 net → Destination LAN1 net1.

Créez une règle sur LAN1 : Source LAN1 net → Destination LAN2 net2.

Bloquer le trafic entre LAN1 et LAN2

Pour isoler complètement les réseaux :

Allez dans Firewall → Rules1.

Vérifiez qu'il n'y a aucune règle permettant le trafic entre LAN1 et LAN22.

Par défaut, le trafic est bloqué (deny all)3.

Configuration NAT (Network Address Translation)

pfSense configure automatiquement le NAT pour WAN. Pour vérifier :

Allez dans Firewall → NAT → Outbound1.

Le mode Automatic outbound NAT devrait être activé2.

Cela permet aux machines sur LAN1 et LAN2 d'accéder à Internet via WAN3.

9️⃣ Configuration avancée (Optionnel)

Activer SSH

Pour accéder à pfSense via SSH :

Dans l'interface web : System → Advanced → Admin Access1.

Cochez Enable Secure Shell2.

Cliquez sur Save3.

Ou depuis la console :

Tapez 14 dans le menu principal1.

Confirmez l'activation2.



Configurer des règles firewall avancées

Firewall → Rules : Créez des règles personnalisées1.

Firewall → Aliases : Créez des alias pour simplifier les règles2.

Firewall → Schedules : Planifiez l'activation/désactivation de règles3.

Monitoring et logs

Status → Dashboard : Vue d'ensemble du système1.

Status → Interfaces : État des interfaces réseau2.

Status → System Logs : Consulter les logs système3.

Status → Firewall Logs : Consulter les logs du firewall4.

Packages et plugins

pfSense supporte des packages additionnels :

System → Package Manager1.

Installez des packages comme :2.
pfBlockerNG : Blocage de publicités et malware

Snort : Système de détection d'intrusion

OpenVPN : Serveur VPN

Squid : Proxy cache

� Astuces VMware

Accès depuis le PC hôte

Pour accéder aux réseaux Host-only depuis votre PC hôte :

Configurez votre carte réseau physique pour utiliser le réseau Host-only1.

Ou créez une VM cliente sur le même réseau Host-only2.

Les VM sur le même réseau Host-only peuvent communiquer entre elles3.

Tester avec plusieurs VM

Pour créer un environnement de test complet :

Créez plusieurs VM (Windows, Linux, etc.)1.

Connectez-les aux réseaux Host-only appropriés2.

Configurez-les pour utiliser pfSense comme passerelle par défaut3.

Testez la communication entre les réseaux4.

Réseaux Internal (Isolation totale)

Si vous voulez des réseaux complètement isolés (sans accès depuis l'hôte) :

Utilisez Internal Network au lieu de Host-only1.

Créez des réseaux Internal distincts pour chaque LAN2.



Seules les VM sur le même réseau Internal peuvent communiquer3.

Snapshots VMware

Avant de faire des modifications importantes :

VM → Snapshot → Take Snapshot1.

Nommez le snapshot (ex: "Avant modification firewall")2.

Si quelque chose ne fonctionne pas, restaurez le snapshot3.

� Dépannage

La VM ne démarre pas

Vérifiez que l'ISO est bien monté

Vérifiez les paramètres de la VM (RAM, CPU)

Consultez les logs VMware

Impossible d'accéder à l'interface web

Vérifiez que votre PC hôte est sur le bon réseau Host-only

Vérifiez l'adresse IP de votre PC hôte

Vérifiez que pfSense a bien démarré (console)

Essayez de ping 192.168.1.1 depuis votre PC hôte

Les interfaces ne sont pas détectées

Vérifiez que les cartes réseau sont bien connectées dans VMware

Vérifiez que les cartes sont activées dans les paramètres de la VM

Redémarrez la VM

Le DHCP ne fonctionne pas

Vérifiez que le serveur DHCP est activé sur l'interface

Vérifiez la plage d'adresses IP

Vérifiez les logs dans Status → DHCP Leases

Pas d'accès Internet depuis LAN1/LAN2

Vérifiez que WAN a bien une adresse IP (via DHCP ou statique)

Vérifiez les règles NAT dans Firewall → NAT

Vérifiez les règles firewall qui pourraient bloquer le trafic

Testez la connectivité depuis la console : ping 8.8.8.8



� Ressources complémentaires

Téléchargements

pfSense Installer AMD64 ISO - Pour VMware sur architecture x86_64

pfSense Installer ARM64 IMG - Pour architecture ARM64

Documentation officielle

Documentation pfSense

Guide utilisateur pfSense

Forum pfSense

Vidéos et tutoriels

Chaîne YouTube officielle pfSense

Tutoriels sur la configuration avancée

Communauté

Reddit r/pfSense

Discord pfSense

Conclusion

Vous  avez  maintenant  installé  et  configuré  pfSense  sur  VMware  avec  plusieurs  interfaces
réseau. pfSense vous permet de :

Créer des réseaux isolés pour vos tests

Configurer un firewall avancé

Gérer le routage entre plusieurs réseaux

Monitorer le trafic réseau

Tester des configurations réseau complexes

N'hésitez pas à explorer les fonctionnalités avancées de pfSense pour personnaliser votre
environnement selon vos besoins !

https://nouvy-agency.fr/wiki-elements/isos-pfsense/netgate-installer-amd64.iso
https://nouvy-agency.fr/wiki-elements/isos-pfsense/netgate-installer-aarch64.img
https://docs.netgate.com/pfsense/
https://docs.netgate.com/pfsense/en/latest/
https://forum.netgate.com/
https://www.youtube.com/user/pfsense
https://www.reddit.com/r/PFSENSE/
https://discord.gg/pfsense

